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Overview

The Getting Started help book contains topics to explain using this help system and the structure (layouts and elements) of the System Configuration window and Maintenance Form (that is, the functions of the tabs, buttons and toolbars 
used).

What would you like to do?

View the Using the Help System Overview

View the System Configuration window - shows layout: Title bar, Tabs, Options and Buttons

View the Maintenance Form - shows layout: Title bar, Tabs and Buttons

Use the Record Toolbar - to navigate through the records

Use the Page Toolbar - to navigate the pages of the record

Use the Mode Toolbar - for maintenance of records

Add a Record

Edit a Record

Delete a Record

Find/Filter a Record

Sort a Record - to rearrange records

Using Help Overview

What would you like to learn about ?

Accessing the Help system

Moving around the Help system

Actions that can be performed

The Contents tab

The Index tab

The Search tab

Use of the toolbar

Printing Help

Closing the Help system

Accessing the Help System

There are several ways that the Help system may be accessed:

Getting Around Help

Several navigational tools are provided to help you progress through the topics of this help system. These tools are summarised below:

By... How...

Using the Help button on the open application. CLICK ON THE Help BUTTON.

From the Help option on the Menu Bar.

SELECT Help FROM THE MENU BAR.

SELECT Contents.

From the On Line Help button on the Task Console. CLICK ON THE On Line Help BUTTON

-OR- PRESS Alt+O.

Using the F1 key on the keyboard. PRESS THE F1 KEY.

Tool Meaning and what to do

The Contents tab is made up of books and topics organised by subject order. Double-clicking on the required book, opens the book and allows the contents to 
be viewed. Click the topic (page icon) to open it. The selected topic will then be displayed on the right-side of the Help window. More information
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Actions that can be Performed

Within this Help system, any actions you need to perform are shown in BLUE. Other actions possible within a help topic are shown below:

Note: When any of these actions are possible, the cursor changes into a hand.

The Contents Tab

This tab is like the Contents section usually found at the front of a book. It is made up of books and topics, organised by subject order, and provides a broad overview of the Help system. Books represent the functional areas of the system 
and each book contains a group of topics. Topics are individual units of information, with textual descriptions and pictures of relevant parts of the system. Double-clicking on the required book, opens the book and allows the contents to 
be viewed. Click the topic (page icon) to open it. The selected topic will then be displayed on the right-side of the Help window.

You can close a book by double-clicking it.

The Index Tab

The Index tab is usually found at the back of a book and contains an alphabetical register of all the topics and main words found in the Âctive Business Series Help system. It's purpose is to allow you to quickly find what you are looking for 
using a word search facility.

The Index tab contains an alphabetical register of all the topics and main words within this help system. More information

When you enter a word or phrase in the Search tab and click List Topics, the contents of the topics are searched to find all occurrences of that word or phrase. 
More information

These buttons are used to navigate through the topics you have visited. More information

Style Meaning and what to do Example

Plain coloured text Definition.

Click on the text to show the definition. Click again to hide.

CLICK ON Definition

Underlined coloured text Link to another topic or place within a topic.

Click on the text to jump to another topic.

Use the Back button on the toolbar to return to the topic you were originally viewing.

CLICK THE underlined text to jump to the bottom of the page.

CLICK THE Back BUTTON TO RETURN.

Thick border around an image. Active graphic, that is, areas or buttons shown on the image will link to another topic.

Click on the relevant area on the image to jump to another topic. CLICK ON EITHER Contents OR Index IN THIS PICTURE to take 
you to the Contents or Index tab section of Help.

CLICK THE Back BUTTON TO RETURN.

Plain uppercase text Click on the word to view an example. Click away to hide. EXAMPLE

xxx Shortcut to another topic.

Click on the button to jump to another topic.

 Link to the Contents Tab
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You may type a phrase or word into the keyword to find field and the nearest match will be highlighted in the index list below. Alternatively, use the scroll bar to aid the viewing of the complete list to select the desired word. 

You may double-click the selected word, or click the word and then select the Display button, (located at the bottom of the tab), to display the topic(s) for the word selected.

If several topics are associated with the word, when the Display button is selected, another window, called Topics Found, opens with the associated topics listed. Double-click the desired topic, or click the required topic and then select the 
Display button.

EXAMPLE

The Search Tab

When you enter a word or phrase in the Search tab and click List Topics, the contents of the topics are searched to find all occurrences of that word or phrase. Topics are ranked but any topic from the list may be selected to display the 
topic on the right.

Enhanced searching can be performed by entering the appropriate AND, OR, NOT or NEAR operators. More information

The Help System Toolbar

At the top of the Help window, a toolbar provides the following functions:

Printing Help

The print button on the Help System Toolbar is used to print the Help topic you are currently viewing.

If the Contents tab is active, a sub-menu containing two print options are available on the Print Topics window that opens:

© Torex Retail Holdings Limited 2011. All rights reserved.

Button Meaning and what to do

These buttons are used to navigate through the Help pages. The Help system will remember the route taken through topics and links, hence you may use the Back and Forward buttons to 
move backwards and forwards through the topics you have referenced.

The print button is used to print the Help topic you are currently viewing. More information

Action What to do

To print a single topic: CLICK Print.

SELECT Print the selected topic.

This is the default option used for printing the current topic. 

To print all topics in a selected book: CLICK Print.
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CLICK THE OK BUTTON.

After selecting the print option or if the Index tab is active, the Print window opens detailing the default printer and its settings.

AMEND PRINT OPTIONS, IF REQUIRED.

CLICK THE OK BUTTON.

Occasionally, if a topic is selected for print using the option, Print the selected heading and all subtopics, and no subtopics actually exist, upon selecting OK on the Print Window, the following error occurs:

It is recommended to:

CLICK THE No BUTTON.

The topic will continue to print and a print confirmation may open.

CLICK THE OK BUTTON.

EXIT THE HELP SYSTEM.

RE-OPEN THE HELP SYSTEM IF REQUIRED.

Closing the Help System

To close the Help system you may use any of the following methods:

Tips

About the Window

Note: This Help system may display tabs and menu options that are not present on your own system due to your outlets configuration.

System Configuration is a powerful and sophisticated management tool that allows you to set up and fully maintain (add, modify, delete) all of the system data. The core is a master database of tables containing records of all the data.

This topic gives an overview of the System Configuration window and its layout.

Open the System Configuration window. How ?

The image below is active, that is CLICK ON AN AREA to jump to Help on that section or continue reading the Help below.

SELECT Print the selected heading and all subtopics.

Each topic will print concurrently and not on separate pages. If topics are required to be printed on separate pages, it is recommended to 
print each topic individually using the option above. Also, if no subtopics exist for the chosen topic, use the default option above.

By... How...

From the Close button on the Title Bar.

CLICK ON THE X BUTTON.

Using the keyboard. PRESS Alt+F4 SIMULTANEOUSLY.

Press the F1 key to access Help even if no Help button exists on the window.

Click the Back icon to return to the previously viewed topic. Click Forward to go to the topic that was displayed prior to going back.

Click Print to print the current topic. If topics include expanding or drop-down hotspots, display the information before you print.

© Torex Retail Holdings Limited 2011. All rights reserved.
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Title Bar

The title bar shows the name of the window that is open. i.e. System Configuration. At the top right corner of the window, on the title bar, there is the Close button.

Clicking the Close button closes this window and returns you to the Âctive Business Series window.

Tabs

The window contains 4 tabs, each providing access to a different area of configuration. The contents of each of these tabs are fully explained in greater detail in separate topics of their respective Options help book.

Options

Within each of the tabs, available options that may be selected are listed. A description of each option is adjacent to the option.

Buttons

At the bottom of the System Configuration window, three buttons are present. These buttons are:

 ... opens the Help System for System Configuration.

 ... opens the Maintenance Form for the option highlighted.

 ... closes the System Configuration window and returns you to the Âctive Business Series window.

About the Tabs

The window contains up to 4 tabs, each providing access to a different area of configuration. The contents of each of these tabs are fully explained in greater detail in separate topics of their respective help book. Tables are categorised 
into one of the following groups:

e-POS - all electronic Point of Sales (e-POS) activities such as Selling Prices, Sales Items, and setting up Bill Messages.

Stock - all aspects of Stock such as Stock Items, Product Recipes, Stock Rooms, Units of Measure, Allowance Groups.

Hardware - configuration of Terminals, Cash Drawers, Printers, Print Formats.

Administration - system configuration settings for general management of the system not included in the other tabs.

Within each tab, there are two columns: one column showing a list of options available, with a description of the option in the second column. The layout of the list of options under the tabs may be changed. Scroll bars may be present if 
the lists exceed the window size.

Selecting Options

© Torex Retail Holdings Limited 2011. All rights reserved.
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Whenever an option is selected, the following 'Please Wait' window opens whilst the Maintenance Form is built.

 Click here to jump to the About the Maintenance Form help topic.

You may change the way the list of options are laid out under the tabs. How ?

The default setting is Report and is laid out as shown below.

Using this view, the icons are listed vertically with the Options and Description columns displayed. It is the view that gives the most information. Other views, show icons with the option names listed horizontally or vertically with no other 
information displayed. Changing the view does not affect any information and is a matter of preference. Upon re-entry to System Configuration, the icons are back in the default Report view layout.

EXAMPLE of the List layout view.

About the Maintenance Form

The Edit tab allows you to work on individual records. The first record of the System Configuration option selected is displayed as default. The field names and data displayed will vary for each option selected. For example, the example 
below represents the first record in our database for the ePOS option - Generic Item Group.

The lower part of the Maintenance Form window in the Edit Tab view contains a common set of toolbars:

Edit Tab

The Edit tab allows you to work on individual records. The first record of the System Configuration option selected is displayed as default. The field names and data displayed will vary for each option selected. For example, the example 
below represents the first record in our database for the ePOS option - Generic Item Group.

To select an option on a tab within the System Configuration window: CLICK THE OPTION YOU REQUIRE AND CLICK THE Select BUTTON
-OR-
DOUBLE-CLICK THE OPTION REQUIRED.

© Torex Retail Holdings Limited 2011. All rights reserved.

Page Toolbar - to navigate the pages of the record. Click to jump to Help on the Page Toolbar.

Record Toolbar - to navigate through the records. Click to jump to Help on the Record Toolbar.

Mode Toolbar - for maintenance of records. Click to jump to Help on the Mode Toolbar.
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The lower part of the Maintenance Form window in the Edit Tab view contains a common set of toolbars:

View Tab

The View tab allows multiple records to be displayed. If no records exist for the System Configuration option selected, the View tab will be greyed out and not accessible. The column headings represent each field name of the record as 
shown on the Edit tab. The field names and field data displayed will vary for each option selected from the System Configuration window. For example, the example below represents the records for the ePOS option - Generic Item Group. 
Each row represents a record. Horizontal or vertical scroll bars may be present if the number of columns or rows exceed the window size.

If a record is selected on the View tab, a triangular marker appears in the first grey cell of the record row. e.g. Generic Item Group ID 30 has been selected in the View tab shown above. If the Edit tab is subsequently selected, this record 
will be displayed to allow it to be worked on. Specific records may be searched for using the Find button, or, the records may be sorted using the Order button.

You may also change column widths to allow more columns to be viewed at once. How ?

EXAMPLE of changing column widths.

Page Toolbar

The Page Toolbar is located on the lower part of the Maintenance Form window in the Edit Tab view and is used for navigating records. Occasionally, all the fields for the record displayed cannot be contained on one page and continues 
on other pages. The Page Toolbar allows navigation of the pages of the record, one page at a time, forwards and backwards using two buttons: Back Page and Next Page. The Page Toolbar caption displays the current page number and 
the total pages available. For example, Page 1 of 2, Page 2 of 4. To proceed through the pages, click on the appropriate button for the direction of travel required.

EXAMPLE

Note: If only one page is present, both of the buttons will be greyed out and will be disabled, as there is no previous or next page to display.

For example, Page 1 of 1 shown below, both buttons are disabled.

Record Toolbar

Page Toolbar - to navigate the pages of the record. Click to jump to Help on the Page Toolbar.

Record Toolbar - to navigate through the records. Click to jump to Help on the Record Toolbar.

Mode Toolbar - for maintenance of records. Click to jump to Help on the Mode Toolbar.

© Torex Retail Holdings Limited 2011. All rights reserved.
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The Record Toolbar is located on the lower part of the Maintenance Form window in the Edit Tab view. This toolbar consists of four buttons, with arrows pointing in the direction of travel, to navigate through the records. The outer buttons 
represent the Go To commands for the first and last record respectively. The inner buttons allow navigation, one record at a time, forwards and backwards. The toolbar caption displays the current record displayed, out of the total records 
available for that System Configuration option. For example, Record 2 of 8.

To proceed through the records, click on the appropriate button for the direction of travel required.

EXAMPLE

In a large database, navigating through the records to find a specific record takes too much time. Instead, you may search for the record using the Find button.

Mode Toolbar

The Mode Toolbar is located on the lower part of the Maintenance Form window in the Edit Tab view and it allows for maintenance of records. New records can be created, as well as changes and deletions to existing records. The Mode 
Toolbar caption changes according to the event occurring at the time. Upon initial entry to the Maintenance Form window, the Mode : View caption is displayed. This toolbar has five buttons (four active): New, Copy, Edit and Delete. The 
fifth button, Save, is only active when a new record has been created or an existing record copied or amended.

Click on a button below to jump for further Help information.

 ... to create a new record from a blank Maintenance Form. Only available when the selected option has been configured to allow new records and the maximum number of records has not been exceeded.

 ... to create a new record as a copy of the one currently displayed. Only available when the selected option has been configured to allow new records and the maximum number of records has not been exceeded. Also, there 
must be at least one record to copy.

 ... to modify an existing record. This button is only available when the current option has been configured as being read/write. 

Whilst in the Edit mode, this button changes to the Revert button. This allows you to undo the changes and restore the original entries.

 ... to delete a record. Only available if the selected option has been configured to allow deletes and the record is not linked to another record.

 ... to save a record. Only active when creating a new record or when copying or amending an existing record.

Creating Records

New records can be created in two ways:

For certain options, new records cannot be created. This may be because the permitted maximum number of records allowed has been reached or the option has been configured to not allow adding of records. For example, in the Outlet 
option, configuration allows only one record to exist.

Note: When the system is auto-generating a number, it adds one to the highest number that already exists. When it reaches the maximum number of records allowed for that table, it looks back through all the existing records to see if 
there is a gap in the numbers it can use. Hence, ID numbers may not increment in sequence.

New Records

To create a new record from a blank Maintenance Form:

CLICK ON THE New BUTTON ON THE Mode : View TOOLBAR.

A blank record of the system configuration option selected opens. Certain fields such as unique ID numbers are automatically filled with the lowest available number. Click for more information on the elements when working on records.

The cursor will be flashing in the first field that requires information. Text entered may automatically appear in uppercase but this is configurable. At the bottom of the blank record, a description of the input required is displayed. As you 
progress through the input fields, the description updates to reflect the information required.

TYPE THE ENTRY FOR THE FIRST FIELD.

To move to the next field:

PRESS TAB OR CLICK ON THE NEXT FIELD.

REPEAT FOR EACH INPUT FIELD.

When all fields have been completed on the Maintenance Form, to save the record:

CLICK THE Save BUTTON ON THE Mode : New TOOLBAR. 

CLICK THE Yes BUTTON.

EXAMPLE

You will be returned to the Maintenance Form with the new record displayed.

When you add a new record, it will be placed after the last existing record and the Record Toolbar caption will show an increment of one. It is not necessary to enter records in a particular order as you can easily rearrange them by sorting 
using the Order button.

Note: If any data has been inputted and the Close button is selected, you are prompted to save the changes made to the record.

© Torex Retail Holdings Limited 2011. All rights reserved.
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Copying Records

When creating new records such as new sales items, it may be quicker to copy an existing record and edit the differences.

Locate the record you wish to copy using the Record Toolbar or the Find button.

CLICK THE Copy BUTTON ON THE Mode : View TOOLBAR.

The Maintenance Form for that record opens. It is an exact duplicate of the original record except any unique ID numbers will be updated to reflect the next lowest number available. Click for more information on the elements when 
working on records.

AMEND FIELDS AS NECESSARY TO CREATE A NEW RECORD.

When all fields have been completed on the Maintenance Form, to save the record:

CLICK THE Save BUTTON ON THE Mode : Copy TOOLBAR. 

CLICK THE Yes BUTTON.

You will be returned to the Maintenance Form with the new record displayed.

When you add a new record, it will be placed after the last existing record and the Record Toolbar caption will show an increment of one. It is not necessary to enter records in a particular order as you can easily rearrange them by sorting 
using the Order button.

Note: If any data has been inputted and the Close button is selected, you are prompted to save the changes made to the record.

Editing Records

You can update individual records to reflect new information. Upon opening the Maintenance Form for a selected option, the records displayed are read-only. The edit option is only available when the option selected has been configured 
as being read/write.

To modify an existing record, locate the record you wish to update using the Record Toolbar or the Find button.

CLICK THE Edit BUTTON ON THE Mode : View TOOLBAR.

The Maintenance Form for that record opens. Click for more information on the elements when working on records.

MAKE CHANGES AS NECESSARY.

To save the changes:

CLICK THE Save BUTTON.

A confirmation window opens with the question 'Save changes to current record?'.

EXAMPLE

CLICK THE Yes BUTTON.

Note: Caution must be used when amending certain records that may effect subsequent stocktakes or the tracking of an item. 

Saving Records

When adding or editing a record, to save the details on the Maintenance Form:

CLICK THE Save BUTTON.

A confirmation window opens with the question 'Save changes to current record?'. A summary of the update is displayed so that it can be verified before being applied.

To exit the window and save the entries: 

CLICK THE Yes BUTTON.

You will be returned to the Maintenance Form with the new record displayed.
EXAMPLE

If the Save button is clicked whilst no data, incomplete data or duplicate data is entered in the input fields, an error window will open. This window will list either the empty fields or the duplicate fields. EXAMPLE

The Revert (Undo) button allows you to exit the window without saving any entries made. A confirmation window opens with the question 'Undo changes to current record?' and a list of fields and their input. EXAMPLE

To exit the window and revert to the original Maintenance Form:

CLICK THE Yes BUTTON.

Deleting Records

For certain options, the delete icon will be greyed out and hence, records may not be deleted. This may be because:

 the permitted minimum number of records allowed has been reached or

 the record is linked to another record or 

 the option has been configured to not allow deleting of records. 

Locate the record you wish to delete using the Record Toolbar or the Find button.

CLICK THE Delete BUTTON ON THE Mode : View TOOLBAR.

A question prompt will be displayed:

© Torex Retail Holdings Limited 2011. All rights reserved.
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To delete the selected record,

CLICK THE Yes BUTTON.

The system validates whether a record is linked (related) to another record on another table. If the record is linked, deletion of the record is prevented and a window opens denoting the link. For example, in our example below an individual 
Sales Item could not be deleted as it was linked to a record within the Recipe table.

CLICK THE OK BUTTON.

The window will close and the record will remain in the database. 

Note: Caution must be used when deleting certain records that may effect subsequent stocktakes or the tracking of an item.

Finding Records

In a big database you may want to see or work on a subset or partial list of data. For example, you may wish to find all Spirits within the Generic Item Group. When you use the Find command, the system will search the database and will 
find records that meet the specifications entered.

Open the System Configuration window. How ?

Open the Maintenance Form for the chosen System Configuration option. How ?

Note: If no records exist in the System Configuration option selected, the Find button will be greyed out.

To create a subset:

CLICK THE Find BUTTON.

The following window opens:

Note: If previous search criteria exists, it may be deleted using the Clear button. If no previous search criteria exists, as in the above picture, the Clear button is greyed out and unavailable.

The specifications you enter to find records are called criteria. Three fields must be completed to create the search criteria:

Once created, this search criteria needs to be added to the Find table.

CLICK THE Add BUTTON.

Filter - the field name (Column) to include in the search.

Operator - the operation to perform.

Condition - the value or text to apply.

© Torex Retail Holdings Limited 2011. All rights reserved.
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Note: Text entered as the condition, is enclosed in quotation marks in the Find table. Do not enter quotation marks when entering text.

To start the search:

CLICK THE Ok BUTTON.

The ePOS - Generic Item Group table is searched and only those records that meet your criteria are displayed. For example, all ePOS - Generic Item Group records that belong to the SPIRITS Category.

The tooltip for the Find button contains the search criteria last used. e.g. In the example above, the tooltip for the Find button displays Category = SPIRITS.

Filtering temporarily hides all records in the database that do not satisfy the criteria. When you exit the window, all records are reinserted ready for the next time.

If your search does not produce the results you want, you may wish to create new search criteria. Existing search criteria requires clearing/removing prior to a new search being performed.

Creating Search Criteria

The specifications you enter to find records are called criteria. Three fields must be completed to create the search criteria:

Filter

To filter your database:

CLICK ON THE DOWN ARROW (above the greyed out Remove button).

A list of predefined filters that can be applied are displayed. For example, in our example of ePOS - Generic Item Group, there are three filters available equivalent to the field names on the record.

SELECT THE FILTER REQUIRED. e.g. Category

The selected filter will be displayed and two other fields become available to allow the operator and condition to be entered.

Operator

The operator field contains the equals symbol automatically by default. Other operators will be found by clicking on the down arrow.

These Operators produce criteria involving finding exact matches or simple ranges of greater-than or less-than comparisons. Only text fields may have the operator Contains.

Summary of Finding Records

CLICK THE Find BUTTON

CREATE SEARCH CRITERIA: Filter, Operator, Criteria.

ADD TO Find TABLE

ADD MULTIPLE CRITERIA (OPTIONAL)

CLICK THE Ok BUTTON

© Torex Retail Holdings Limited 2011. All rights reserved.

Filter - the field name (Column) to include in the search.

Operator - the operation to perform.

Condition - the value or text to apply.

Operator Meaning Example Finds

= Equal to =20 Fields equal to 20

<> Not equal to <>20 Fields not equal to 20

>= Greater than or equal to >=20 Fields greater than or equal to 20

<= Less than or equal to <=20 Fields less than or equal to 20
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SELECT THE OPERATOR TO APPLY IF THE OPERATOR SHOWN IS NOT REQUIRED.

Condition

The condition field shows the first entry of the selected option by default. (In our example OTHER)

SELECT THE CONDITION TO APPLY IF THE CONDITION SHOWN IS NOT REQUIRED.

Note: For text fields you may type the Condition to apply. The system is not case sensitive, hence entering 'Litre' will find records containing the text LITRE, LITRES and MILLILITRES.

Once created, this search criteria needs to be added to the Find table.

Creating Multiple Search Criteria

You can specify multiple criteria involving AND OR logical operators when you need to find records that satisfy more than one criterion. For example, to search for both Spirits and Table Wines within the ePOS - Generic Item Group 
option.

Create the first criterion of Category = SPIRITS. For more details, refer to the Creating Search Criteria topic.

To enter the second criterion:

SELECT FILTER for example Category 

SELECT OPERATOR for example =

SELECT CONDITION for example TABLE WINES

To add this to the first criterion:

CLICK THE Add BUTTON.

Both criteria will be displayed on the Find table. By default the AND logical operator occurs.

If the OR logical operator is required:

CLICK THE AND CELL.

SELECT OR FROM THE DROP-DOWN LIST.

To start the search:

CLICK THE Ok BUTTON.

The ePOS - Generic Item Group database will be searched and only those records that meet your criteria will be displayed, that is, all those records that belong to either the SPIRITS or TABLE WINES Category.

> Greater than >20 Fields greater than 20

< Less than <20 Fields less than 20

Contains Includes Litre Fields which include the text 'Litre'

Summary of Creating Search Criteria

SELECT FILTER REQUIRED

SELECT OPERATOR TO APPLY

SELECT OR ENTER CONDITION
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Filtering temporarily hides all records in the database that do not satisfy the criteria. When you exit the window, all records are reinserted ready for the next time.

If your search does not produce the results you want, you may wish to create new search criteria. Existing search criteria requires clearing/removing prior to a new search being performed.

Clearing/Removing Search Criteria

When you use the Find command on the Maintenance Form, the system will search the database and will find records that meet the specifications entered. If your search does not produce the results you want, you may wish to change 
the search criteria.

To delete all the search criteria in the Find table:

CLICK THE Clear BUTTON.

To remove selected criterion:

CLICK THE GREY CELL TO THE LEFT OF THE CRITERION TO REMOVE.

A pointer is placed in this cell to indicate the criterion is selected.

CLICK THE Remove BUTTON.

The selected criterion will be removed. Subsequent criterion will move up a row in the Find table. EXAMPLE

Sorting Records

If you do not need to find specific records but merely want to arrange your data in a different sequence, you can use the Order button. You may also order the partial list of data after the Find command has been used. Sorting provides a 
way to display your information in a more logical fashion. To sort a database, you have to state which field(s) you want to sort and how you want to sort it (ascending or descending).

Open the System Configuration window. How ?

Open the Maintenance Form for the chosen System Configuration option. How ?

Note: If no records exist in the System Configuration option selected, the Order button will be greyed out.

To order records:

CLICK ON THE Order BUTTON.

The Set Order window opens. It contains two fields:

Available Columns - contains a list of available field names that can be transferred to the Sort Order field.

Sort Order - contains a list of available field names that have been selected.

The field names displayed will vary for each option selected from the System Configuration window. For example, the example below shows the columns for the ePOS - Generic Item Group option.

Summary of Creating Multiple Search Criteria

CREATE PRIMARY SEARCH CRITERIA: Filter, Operator, Criteria.

ADD TO Find TABLE

CREATE SECONDARY SEARCH CRITERIA: Filter, Operator, Criteria.

ADD TO Find TABLE

CHANGE LOGICAL OPERATOR TO OR, IF REQUIRED

CLICK THE Ok BUTTON
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The transfer of available field names is carried out via a set of four buttons on a toolbar in the middle of the window. These buttons allow field names, either individually or all, to be added or removed. More information about these 
buttons.

The contents of the Sort Order field may be ordered to reflect the priority of sorting. The first field name in the Sort Order field will act as the primary sort, the second name, the secondary sort, and so on. EXAMPLE

For the sequence of records to be identical in both the Edit and View tabs:

SELECT THE Match Edit & View Orders CHECKBOX.

The resulting records may be displayed in Ascending (going up) or Descending (going down) order. To view the records in reverse order:

SELECT THE Descending CHECKBOX.

If the check box is left unchecked, the sort will be in ascending order.

Summary of Performing a Sort

CLICK  THE Order BUTTON

TRANSFER THE FIELD NAMES TO THE Sort Order FIELD

REORDER THE SORT ORDER (OPTIONAL)

CLICK Match Edit & View Orders CHECKBOX IF MATCHING REQUIRED

CLICK Descending CHECKBOX IF REVERSE ORDER REQUIRED

CLICK THE Ok BUTTON
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Build Sales Items

Generates Sales items automatically from SIDs and SITs . This option is covered in greater detail in the Building Sales Items help topic.  Click here to jump to this topic.

Terminator: Name of sales item.

Print Group: If the sales item is to be remotely ordered, name of Print Group to be used for printing.

Printer Format: Printer format to be used when printing the sales item.

VAT: Tax rate that is applied to that sales item.

Category

A Sales Category is the second level of the hierarchy .

It is linked from the Sales Family. Typical examples of categories linked to the Family of LIQUOR would be Draught, Minerals, Spirits.

Each record represents an individual Sales Category. Three fields are displayed on the Category option:

Category ID: Automatically populated with unique Category ID number.

Description/Name: Name of Sales Category (up to 20 characters long).

Family: Name of Sales Family that this Sales Category is a member of.

Family

Top level of the Sales Item hierarchy .

Common examples could be FOOD, LIQUOR, ACCOMMODATION, ADMISSIONS. The LIQUOR Sales Family would include all liquor items sold at an outlet such as minerals, draught beers/lagers. The LIQUOR Sales Family would 
include all liquor items sold.
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Each record represents an individual Sales Family. Two fields are displayed on the Family option:

Family ID: Automatically populated with unique Family ID number.

Description/Name: Name of Sales Family (up to 20 characters long).

Generic Item

A Generic Item is the fourth level of the Sales Item hierarchy .

It is a member of a Generic Item Group. Typical examples of Generic Items linked to a Generic Item Group of VODKA would be:

FAMILY - Liquor

CATEGORY - Spirits

GENERIC ITEM GROUP - Vodka

GENERIC ITEM - Branded, Premium, Flavoured.

Each record represents an individual Generic Item. Three fields are displayed on the Generic Item option:

Generic Item ID: Automatically populated with unique Generic Item ID number.

Description/Name: Name of Generic Item (up to 20 characters long).

Generic Item Group: Name of Generic Item Group that this Generic Item belongs to.

Generic Item Group

A Generic Item Group is the third level of the Sales Item hierarchy .

It is linked from the Sales Category. Typical examples of Generic Item Groups linked to a Category of SPIRITS would be:

FAMILY - Liquor

CATEGORY - Spirits

GENERIC ITEM GROUP - Vodka, Whisky, Rum.

Each record represents an individual Generic Item Group. Three fields are displayed on the Generic Item Group option:

Generic Item Group ID: Automatically populated with unique Generic Item Group ID number.

Description/Name: Name of Generic Item Group (up to 20 characters long).

Category: Name of Sales Category that this Generic Item Group is in.

Key Line Tracking Maintenance

Key Line Tracking Maintenance allows for the setup and maintenance of sales items. A maximum of 12 sales items can be tracked and displayed on each of the two FOS reports: Moneybelt Sever Sign Off and Moneybelt Cash Check. 
The tracked items can be either:

 the same on both reports 

 different items on each report 
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Order Message

An order message is a phrase that describes how a Sales Item is to be prepared for the customer for example medium rare or well done for meats, or no mushrooms, with peas, and so on. Messages describing food preparation is printed 
on the remote printers for the chef as defined by the Printer Group. Messages may also be used to specify how the customer would like a drink to be served for example without ice or to specify the number of glasses required when a 
bottle of wine has been ordered. Once created, the message can be added to the screens directly, in the first available position. How ?

The button can then be relocated using the Screen Designer. 

Each record represents an individual Message and consists of 2 pages.

 Page 1  Page 2

The following fields are displayed on the Order Message record:

Page 1

Order Message ID: Automatically populated with unique Order Message ID number.

Description/Name: Name of message (up to 16 characters long).

Keyboard Text: Text displayed on the button of a touch terminal. Three lines are provided but for a single line of text use the middle line. Each line of text may be up to 7 characters long.

Page 2

Print Format: Printer format to be used when printing this message. 

PLU: Product Look Up number that may be used to reference the item.

Summary of Key Line Tracking Maintenance:

1. CHOOSE AN OPTION - EITHER THE SAME OR DIFFERENT SALES ITEMS FOR THE REPORTS

2. CLICK THE Next BUTTON

3. SELECT A SALES CATEGORY FROM THE DROP DOWN LIST THEN SELECT THE SALES ITEM

4. CLICK THE Add BUTTON FOR THE APPROPRIATE REPORT

5. REPEAT STEPS 3 AND 4 FOR EACH SALES ITEM REQUIRED

6. CLICK THE Next BUTTON

7. CLICK THE Finish BUTTON
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Remote Printing Text: A short piece of text, (up to 20 characters long), that describes the way that the Sales Item is prepared. This text is printed on the kitchen printer.

Outlet

The Outlet option displays details of each trading outlet operated by your business.

Each record represents an individual outlet and consists of three pages.

 Page 1  Page 2  Page 3

The following fields are displayed on the Outlet option.

Page 1

Outlet ID: Automatically populated with unique Outlet ID.

Description/Name: Name of trading Outlet (up to 30 characters long).

Address: Four lines of text displaying the Outlet address.

Post Code: Post Code details of Outlet, split into two fields.

Telephone: Telephone number of Outlet.

Page 2

Manager: Name of Manager of this Outlet (up to 30 characters long).

Default Float: Total value of Outlets float.

Currency Symbol: For example 1=$, 2 = £.

Authorisation Type: 12 characters to represent type of authorisation such as Verifone, NatWest.

Deposit B/F: Amount carried forward.

Home Currency: Own country currency.

Change Currency: Currency that any change is to be given in.

Physical Currency:

Page 3

Page 3 contains numerous check boxes. A list is displayed below with a short description of each check box.

Money Belts: Indicates if Money Belt servers (Waitress banking) are allowed.

Bill Pads: Indicates if paper bill pads containing uniquely referenced pages are allowed.

EFTPoS: Electronic Funds Transfer at Point of Sale.

Central EFTPoS: Indicates whether the EFTPoS transaction data is polled to a central system for processing to the banks, rather than by the banks directly.

Multiple Cash Drawers: Indicates if several cash drawers attached to a terminal are permitted.

Dallas Button: Indicates if a Dallas button is used by user for logging on.

Extended User Range:

Print Preview:

Multi-Outlet ODBC Connection: Indicates database being used (up to 20 characters).
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Advanced Deposits: The advanced deposits functionality is only active if this check box is selected.

Advanced Deposit Gratuities: The advanced deposits gratuities functionality is only active if this check box is selected.

Advanced Deposit Forfeit Percent %: Contains the % Deposit forfeit value in the form xxx.xx (for example 010.00 = 10%). If this field is set to 000.00 then there is no Deposit forfeit. The field must contain a valid numeric value.

Outlet Configuration Wizard

The outlet configuration wizard is used to create, modify and delete the configuration of terminals, receipt and kitchen printers, and trading areas within the outlet using a drag and drop interface. This option is covered in greater detail in 
the outlet configuration wizard help book.  Click here to jump to the Outlet Configuration Wizard Overview topic.

Sales Item

Sales items are the actual individual items that can be sold at the outlet. Some sales items such as draught beers, draught lagers and minerals can be sold in various quantities or combinations (shandies, tops, and so on). These sales 
items are made up of a SID and a SIT . Not all sales items have SID/SITs because they will only be sold in a singular form. Once created, the Sales Item can be added to the touch panels directly, in the first available position. How ?

The button can then be relocated using the Screen Designer. 

Each record represents an individual Sales Item and consists of 3 pages.

 Page 1  Page 2  Page 3

The following fields are displayed on the Sales Item record:

Page 1

Sales Item ID: Automatically populated with unique Sales Item ID number.

Sales Item Name/Description: Name of Sales Item (up to 16 characters long) also used in ABS reporting.

Keyboard Text: Text displayed on the button of a touch terminal. Three lines are provided but for a single line of text use the middle line. Each line of text may be up to 7 characters long.

Bill Text: A brief description of this item, (up to 16 characters long), that is printed on the customer bill and receipt.

Remote Printing Text: A short piece of text, (up to 20 characters long), that describes the way that this Sales Item is prepared. This text is printed on the remote printer such as kitchen printer or bar dispense printer.

Page 2

Terminator: Sales Item Terminator name may be displayed if linked to this Sales Item.

Print Group: Printer group in which the item belongs such as Starters, Main Courses, Desserts or Wines, Cocktails etc.

Print Format: Print format (colour, text size, position and order on printout) to be used when printing this Sales Item to a remote printer.

Page 3
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Generic Item: Name of Generic Sales Item that Sales Item is a member of.

ABV %: Alcohol By Volume such as 0380 represents 3.8%.

PLU: Product Look Up number that may be used to reference the sales item.

VAT ID: VAT (tax) rate to apply against the Sales Item.

Price Print: Indicates if price is printed as part of price list.

Variable Price:

Sales Item Route

A Sales Item Route is a chain of Touch Panels. When a server selects an item from the touch screen, the next touch panel in the chain is displayed. Sales Item Routes are useful when dealing with a structured series of items, for example 
a meal. The sequence of screens help prompt the server through a probable selection of items. For example, in a restaurant, a Sales Item Route might be set up so that when the server selects the button for a starter order, the touch 
panel for main courses is displayed. When the main course is selected, the touch panel for potato choice then vegetables is displayed.

Each record represents an individual Sales Item Route. Three fields are displayed on the Sales Item Route record:

Sales Item: Name of Sales Item.

Sequence: The number sequence in which this screen appears after the Sales Item.

Terminal Screen: Name of screen to show.

Sales Item Terminator

A Sales Item Terminator is a description which, when used in combination with a Sales Item Descriptor, further defines an item being sold. Examples of typical SITs are Liebfraumilch, Best Bitter, Gin. Once created, the SIT can be added 
to the touch panels directly, in the first available position. How ?

The button can then be relocated using the Screen Designer. 

Each record represents an individual Sales Item Terminator and consists of two pages.

 Page 1  Page 2 

The following fields are displayed on the Sales Item Terminator record:

Page 1

Sales Item Terminator ID: Automatically populated with unique Sales Item Terminator ID number.

Description/Name: Name of Sales Item Terminator (up to 16 characters long).

Keyboard Text: Text displayed on the button of a touch terminal. Three lines are provided but for a single line of text use the middle line. Each line of text may be up to 7 characters long.

Page 2
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Default Descriptor: Default quantity in which the Sales Item will be sold at the point of sale, for example Small, Pint, Single, Scoop. Normally the most common quantity sold for the relevant item.

Generic Item: Name of Generic Sales Item that SIT is a member of.

Sales Wizard

The Sales Wizard option allows the layout of the terminal screens/touch panels to be created or amended. This option is covered in greater detail in the Sales Wizard help book.  Click here to jump to the Sales Wizard Overview topic.

Screen Creator

Screen creators represent the name given to a touch panel (a panel is used on the point of sale terminal to display groups of sales items or POS action models). Most of the touch panel headers will be of the Sales type. Any new records 
created are shown under the group Free panels in the Screen Designer option. Once created, the touch panel header can be added to the touch panels directly, in the first available position. How ?

The button can then be relocated using the Screen Designer. 

Each record represents the name of an individual screen and consists of three pages.

 Page 1  Page 2  Page 3

The following fields are displayed on the Screen Creator option.

Page 1

Terminal Screen ID: Automatically populated with unique Terminal Screen ID number.

Description/Name: Name of screen as described on the button on the touch terminal for example Main Courses, Pizza, Wine List, Spirits List.

Keyboard Text: Text displayed on the button of a touch terminal. Three lines are provided but for a single line of text use the middle line. Each line of text may be up to 7 characters long.

Minimum: The minimum number of items to be selected from this touch panel in the range 0-15. For example, if 3 is entered the server is forced to select at least 3 items from the touch panel.

Maximum: The maximum number of items available to be selected from this touch panel in the range 0-15. For example, if 3 is entered, the server is not allowed to select more than 3 items from the touch panel. 15 represents no limit.

Page 2

Terminal Screen Type: Type of touch panel: Sales , Login , Parent, Window .

Terminal Type: The type of terminal to which this key mapping applies for example Touch RT, Wedge, Handheld.

Alternative Prompt: Used for special window messages to staff such as 'Do not forget the change' or ' Tickets for Christmas Ball'.

Outlet Maintainable: Indicates if maintenance of touch panels can be maintained at the outlet.

Page 3

The settings on the third page control the position and size of the Command Window. The Command Window is used on the touch panels for displaying prompts and menu lists. If all values are zeros, the properties for the Command 
Window are taken from the settings used in Terminal Type.

The touch panel is usually represented by a grid format of 10 by 10 cells for the terminal. The first cell would be represented by position top =0, left =0.
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Command Window Position, Top: Position of top corner of Command Window - number of cells down grid.

Command Window Position, Left: Position of top corner of Command Window - number of cells across grid.

Command Window, Width: Width of Command Window, measured in number of cells.

Command Window, Height: Height of Command Window, measured in number of cells.

Click to view an example of different settings for the Command Window.

 Top=0, Left=2: Width=6, Height=3

 Top=3, Left=3: Width=4, Height=4

 Top=2, Left=0: Width=3, Height=6

Screen Designer

The Screen Designer option allows the layout of the touch panels to be created or amended. This option is covered in greater detail in the Screen Designer help book.  Click here to jump to the Screen Designer Overview topic.

Selling Price

The selling price of sales items may be updated. These price changes can be either for a selected individual item or for a group of items and can be specific to certain trading areas and/or trading modes. The price changes may take effect 
at the next session (extract) or on a selected date. This option is covered in more detail in the Updating Selling Prices Help book.  Click here to jump to this topic.

Selling Price Specials

Prices may be updated for each sales item that is classified as a special (where the price can be changed at the terminal). These price changes can be either for an individual item or for a group of items. The price change(s) will take effect 
at the next session and covers all trading modes and areas. This option is covered in more detail in the Updating Selling Price Specials Help book. Click here to jump to this topic.
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Summary of Updating Selling Prices:

1. SELECT WHEN THE CHANGES ARE TO TAKE EFFECT

2. CLICK THE Next BUTTON

3. SELECT THE Sales Item(s) TO UPDATE

4. ENTER THE NEW PRICES FOR EACH TRADING MODE AND TRADING AREA AS REQUIRED

5. CLICK THE Apply BUTTON

6. CLICK THE View Changes BUTTON (Optional)
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Update Bill Message

Bill messages are the messages printed on bills and receipts. A bill is printed before payment and confirms the details of the sale. A receipt is printed after payment and is a valid tax (VAT) receipt which shows the tax (VAT) information 
about the transaction as stipulated by Customs and Excise. One bill message and one receipt message can be defined for each brand at an outlet.

Each record represents the bill and receipt message for a brand. The following fields are displayed on the Update Bill Message option.

Brand: Trading theme to which these bill and receipt messages will apply.

Bill Text: Six lines of text, with up to 40 characters per line, for a message to be shown on the bill.

Receipt Text: Four lines of text, with up to 40 characters per line, for a message to be displayed on the receipt.

Language: Language used (English, French, German, Spanish).

Validate and Install Bulk Update

The Validate & Bulk Update option is a method of updating the system touch panels with new ones, sent from a central location. It can also update other information such as Selling Prices, Sales Item Routes and SIPs . The target 
installation date is checked every night by the system. A message is written to the Exception Auditor if the date has passed informing that the Bulk Update file is to be installed.

It is a two stage process:

 First, the data file must be validated and, if validation is successful,

 the file may be installed.

This option is covered in detail in the Bulk Update Help book.

 Click here to continue with Help on validating and installing the data file.

Updating Selling Price Specials:

1. SELECT THE Sales Item(s) TO UPDATE

2. ENTER THE NEW PRICES

3. CLICK THE Apply BUTTON

4. CLICK THE View Changes BUTTON (Optional)
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Category

Second level of the Stock Item hierarchy .

A Stock Category is a member of a Stock Family. Examples of typical Stock Categories might be Meals, Beverages, Wines, Spirits.

Each record represents an individual Stock Category. Three fields are displayed on the Category option:

Category ID: Automatically populated with unique Category ID number.

Description/Name: Name of Stock Category (up to 20 characters long).

Family: Name of Stock Family that this Stock Category is in.

Cost Update

Cost Update holds the details of each pending change to the cost of a stock item.

Each record represents an individual Stock Item. The following fields are displayed on the Cost Update option.

Stock Item: Name of Stock Item.

Unit of Measure: Holding unit of measure of the Stock Item.

Unit Cost: The new cost price of the Stock Item.

Effective Date: Date and time for cost update to become effective.

Actioned: Read-only checkbox that is automatically populated when cost update has been applied.

Family

Top level of the Stock Item hierarchy .

Common examples could be FOOD and DRINK. The DRINK Stock Family would include all drinks sold at an outlet. The FOOD Stock Family would include items such as meals and snacks.

Each record represents an individual Stock Family. Two fields are displayed on the Family option:

Family ID: Automatically populated with unique Family ID number.

Family Description/Name: Name of Stock Family (up to 20 characters long).

Generic Item

Fourth level of the Stock Item hierarchy .

A Generic Stock Item is a member of a Generic Stock Item Group. Examples of typical Generic Stock Items are Fish Dishes, Beef Burgers, Hock, Cherry Wine.
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Each record represents an individual Generic Item. Three fields are displayed on the Generic Item option:

Generic Item ID: Automatically populated with unique Generic Item ID number.

Description/Name: Name of Generic Item (up to 20 characters long).

Generic Item Group: Name of Generic Item Group that this Generic Item belongs to.

Generic Item Group

Third level of the Stock Item hierarchy .

A Generic Stock Item Group is a member of a Stock Category. Examples of typical Generic Stock Item Groups are Table Wines, Draught Beers, Bar Snacks, Main Courses, Side Orders, Desserts.

Each record represents an individual Generic Item Group. Three fields are displayed on the Generic Item Group option:

Generic Item Group ID: Automatically populated with unique Generic Item Group ID number.

Description/Name: Name of Generic Item Group (up to 20 characters long).

Category: Name of Stock Category that this Generic Item Group belongs to.

Product

A Product is an item that is supplied to an outlet.

Each record represents an individual Product and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Product option:

Page 1

Product ID: Automatically populated with unique Product ID number.

Product Name: Description of Product (up to 20 characters long).

Supplier Reference: Alternative reference for a product.

Customer Reference: Alternative reference for a product.

Supplier: Individual or company supplying product.

Delivery Multiplier: Quantity by which this product is delivered and therefore ordered.

Preferred Product: Indicates if this product is a preferred product for the purposes of the Suggested Ordering system.

Page 2
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EAN Code: Product code.

Product Recipe

The Product Recipe is a formula that is used to convert the constituent Stock elements of a delivered product into items which can then be used to update an outlet's stock following a delivery.

Each record represents an individual Product Recipe and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Product Recipe option:

Page 1

Product: Name of product that is delivered.

Stock Item: Stock item that will be incremented on delivery.

Unit of Measure: UOM by which the stock item is updated.

Counting Unit of Measure: Unit of measure by which the Stock Item is added to the count sheet when this stock item is delivered, sold, or has an allowance entered against it.

Quantity: Decimal number for the quantity of the stock item that will be added to stock when the product is delivered.

Total Cost: This field holds the total cost for this line of the product recipe. 

Note: This may not be the total cost of a product. If the product recipe has multiple records then the cost of the product is the sum of Total Cost for all of the records in the recipe.

Page 2

Allow Cost Change: Indicates if the cost price of a product at time of delivery may be changed. If a product has multiple records in it's product recipe then only one record should have this check box selected.

Save Changed Cost: Indication if the cost price can be saved as the new cost price of this product. The user decides if this cost price should be saved (using the check box on the delivery screen), but this is only enabled if this check box 
is selected.

Allow Part Delivery: Indicates if a part size and part quantity may be entered against a product when performing a stock movement.

Recipe

Recipes are the links between Sales Items and Stock. Each time a Sales Item is sold, the outlet's stock of the various components which form part of that Sales Item, must be decreased by the appropriate amount. This option is covered 
in greater detail in the Adding Recipes topic.
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Each record represents an individual Sales Item and its stock components. If a Sales Item consists of 3 ingredients, 3 lines (one line for each component) will exist for that Sales Item. The sum of all the separate proportions should then 
add up to 100% (Fixed Percentage). The following fields are displayed on the Recipe option.

Sales Item: Name of Sales Item sold.

Sub: Indicates if item has its own sub recipe. For example, the Item Description Salad may have a sub recipe detailing its stock components.

Item Description: Name of Stock Item or recipe that will decrease.

Unit Description: Holding UOM of the Stock Item .Corresponds to the UOM field displayed in the Stock Item option.

Quantity: Amount of the Stock Item.

Value Apportionment Type: The field determines how the sales value from the sales item is divided between the stock items in its recipe. Fixed Value , Fixed % , % Based on Cost Ratio .

Fixed Percentage: Percentage value of stock component if Fixed % or % Based on Cost Ratio Value Apportionment Type is selected.

Fixed Value: Fixed value of stock component if Fixed Value of the Value Apportionment Type is selected.

Total Cost: Total cost of item used in the recipe. Unit Cost x Quantity.

Total Cost: Sum of cost of all items in recipe.

Stock Item

A Stock Item is any item which can be held as Stock at an outlet.

Each record represents an individual Stock Item and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Stock Item option:

Page 1

Stock Item ID: Automatically populated with unique Stock Item ID number.

Description/Name: Name of Stock Item (up to 20 characters long).

Generic Item: Name of Generic Item this Stock Item belongs to.

Holding Unit of Measure: Smallest unit of measure by which the Stock Item is held.

Counting Unit of Measure: Unit of measure by which the Stock Item is added to the count sheet when this stock item is delivered, sold, or has an allowance entered against it.

Reporting Unit of Measure: Unit of measure by which the Stock Item is reported.

Page 2

Unit Cost: Unit cost of this stock item based on its Holding Unit.

Days Minimum Stock: Minimum number of days that stock must be available at the outlet. Used by suggested ordering when calculating an order.

Unit of Measure Multiplier: The number by which the Holding Unit must be multiplied in order to obtain the Counting Unit.

Expected Yield: % return that is, 100% for bottled goods, maybe 95% for draught beer to allow for wastage in running through the pipes.

Trackable: For reporting purposes.
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Recipe (Sub)

When creating recipes, a component may itself have a recipe. For example, for a liqueur coffee, the recipe record could list all the components and include just one line for the coffee element. A recipe for the coffee would be setup as a 
sub recipe. This option is covered in greater detail in the Creating Sub-Recipes topic.

For a description of the fields, refer to the Recipe topic.

Supplier

A Supplier is an individual or a company who supplies products to outlets such as food suppliers, soft drink suppliers, Cash & Carry.

Each record represents an individual Supplier. The following fields are displayed on the Supplier option:

Supplier ID: Automatically populated with unique Supplier ID number.

Description: Name or brief description (up to 20 characters long) of Supplier.

Address: Address of Supplier. Four lines are available, with up to 20 characters per line.

Telephone: Telephone number of Supplier.

Fax: Fax number of Supplier.

E-Mail: E-mail address of Supplier.

VAT: Rate of tax.

The next three fields are used to determine which code is displayed by default next to a product on the Outlet Transfers and Room Transfers screens (for both deliveries and orders). Only one of the three should be enabled.

Show Product Reference: Reference code for a product.

Show Supplier Reference: Alternative reference for a product.

Show Customer Reference: Alternative reference for a product.

Complete Part Delivered Orders: Identifies for a given supplier on delivery against a confirmed order if there is a shortfall in the delivery whether the order is set to COMPLETE or if it remains PART DELIVERED. If selected, the order is set 
to Completed by updating the order against the delivered quantities and then completing any shortfalls in the delivery. The shortfalls in the ordered quantity are identified as Not Delivered. If not selected, shortfalls in the delivery remain On 

Order in Part Delivered Orders.
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Category

Second level of the Stock Item hierarchy .

A Stock Category is a member of a Stock Family. Examples of typical Stock Categories might be Meals, Beverages, Wines, Spirits.

Each record represents an individual Stock Category. Three fields are displayed on the Category option:

Category ID: Automatically populated with unique Category ID number.

Description/Name: Name of Stock Category (up to 20 characters long).

Family: Name of Stock Family that this Stock Category is in.

Cost Update

Cost Update holds the details of each pending change to the cost of a stock item.

Each record represents an individual Stock Item. The following fields are displayed on the Cost Update option.

Stock Item: Name of Stock Item.

Unit of Measure: Holding unit of measure of the Stock Item.

Unit Cost: The new cost price of the Stock Item.

Effective Date: Date and time for cost update to become effective.

Actioned: Read-only checkbox that is automatically populated when cost update has been applied.

Family

Top level of the Stock Item hierarchy .

Common examples could be FOOD and DRINK. The DRINK Stock Family would include all drinks sold at an outlet. The FOOD Stock Family would include items such as meals and snacks.

Each record represents an individual Stock Family. Two fields are displayed on the Family option:

Family ID: Automatically populated with unique Family ID number.

Family Description/Name: Name of Stock Family (up to 20 characters long).

Generic Item

Fourth level of the Stock Item hierarchy .

A Generic Stock Item is a member of a Generic Stock Item Group. Examples of typical Generic Stock Items are Fish Dishes, Beef Burgers, Hock, Cherry Wine.
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Each record represents an individual Generic Item. Three fields are displayed on the Generic Item option:

Generic Item ID: Automatically populated with unique Generic Item ID number.

Description/Name: Name of Generic Item (up to 20 characters long).

Generic Item Group: Name of Generic Item Group that this Generic Item belongs to.

Generic Item Group

Third level of the Stock Item hierarchy .

A Generic Stock Item Group is a member of a Stock Category. Examples of typical Generic Stock Item Groups are Table Wines, Draught Beers, Bar Snacks, Main Courses, Side Orders, Desserts.

Each record represents an individual Generic Item Group. Three fields are displayed on the Generic Item Group option:

Generic Item Group ID: Automatically populated with unique Generic Item Group ID number.

Description/Name: Name of Generic Item Group (up to 20 characters long).

Category: Name of Stock Category that this Generic Item Group belongs to.

Product

A Product is an item that is supplied to an outlet.

Each record represents an individual Product and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Product option:

Page 1

Product ID: Automatically populated with unique Product ID number.

Product Name: Description of Product (up to 20 characters long).

Supplier Reference: Alternative reference for a product.

Customer Reference: Alternative reference for a product.

Supplier: Individual or company supplying product.

Delivery Multiplier: Quantity by which this product is delivered and therefore ordered.

Preferred Product: Indicates if this product is a preferred product for the purposes of the Suggested Ordering system.

Page 2
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EAN Code: Product code.

Product Recipe

The Product Recipe is a formula that is used to convert the constituent Stock elements of a delivered product into items which can then be used to update an outlet's stock following a delivery.

Each record represents an individual Product Recipe and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Product Recipe option:

Page 1

Product: Name of product that is delivered.

Stock Item: Stock item that will be incremented on delivery.

Unit of Measure: UOM by which the stock item is updated.

Counting Unit of Measure: Unit of measure by which the Stock Item is added to the count sheet when this stock item is delivered, sold, or has an allowance entered against it.

Quantity: Decimal number for the quantity of the stock item that will be added to stock when the product is delivered.

Total Cost: This field holds the total cost for this line of the product recipe. 

Note: This may not be the total cost of a product. If the product recipe has multiple records then the cost of the product is the sum of Total Cost for all of the records in the recipe.

Page 2

Allow Cost Change: Indicates if the cost price of a product at time of delivery may be changed. If a product has multiple records in it's product recipe then only one record should have this check box selected.

Save Changed Cost: Indication if the cost price can be saved as the new cost price of this product. The user decides if this cost price should be saved (using the check box on the delivery screen), but this is only enabled if this check box 
is selected.

Allow Part Delivery: Indicates if a part size and part quantity may be entered against a product when performing a stock movement.

Recipe

Recipes are the links between Sales Items and Stock. Each time a Sales Item is sold, the outlet's stock of the various components which form part of that Sales Item, must be decreased by the appropriate amount. This option is covered 
in greater detail in the Adding Recipes topic.
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Each record represents an individual Sales Item and its stock components. If a Sales Item consists of 3 ingredients, 3 lines (one line for each component) will exist for that Sales Item. The sum of all the separate proportions should then 
add up to 100% (Fixed Percentage). The following fields are displayed on the Recipe option.

Sales Item: Name of Sales Item sold.

Sub: Indicates if item has its own sub recipe. For example, the Item Description Salad may have a sub recipe detailing its stock components.

Item Description: Name of Stock Item or recipe that will decrease.

Unit Description: Holding UOM of the Stock Item .Corresponds to the UOM field displayed in the Stock Item option.

Quantity: Amount of the Stock Item.

Value Apportionment Type: The field determines how the sales value from the sales item is divided between the stock items in its recipe. Fixed Value , Fixed % , % Based on Cost Ratio .

Fixed Percentage: Percentage value of stock component if Fixed % or % Based on Cost Ratio Value Apportionment Type is selected.

Fixed Value: Fixed value of stock component if Fixed Value of the Value Apportionment Type is selected.

Total Cost: Total cost of item used in the recipe. Unit Cost x Quantity.

Total Cost: Sum of cost of all items in recipe.

Stock Item

A Stock Item is any item which can be held as Stock at an outlet.

Each record represents an individual Stock Item and consists of two pages.

 Page 1  Page 2

The following fields are displayed on the Stock Item option:

Page 1

Stock Item ID: Automatically populated with unique Stock Item ID number.

Description/Name: Name of Stock Item (up to 20 characters long).

Generic Item: Name of Generic Item this Stock Item belongs to.

Holding Unit of Measure: Smallest unit of measure by which the Stock Item is held.

Counting Unit of Measure: Unit of measure by which the Stock Item is added to the count sheet when this stock item is delivered, sold, or has an allowance entered against it.

Reporting Unit of Measure: Unit of measure by which the Stock Item is reported.

Page 2

Unit Cost: Unit cost of this stock item based on its Holding Unit.

Days Minimum Stock: Minimum number of days that stock must be available at the outlet. Used by suggested ordering when calculating an order.

Unit of Measure Multiplier: The number by which the Holding Unit must be multiplied in order to obtain the Counting Unit.

Expected Yield: % return that is, 100% for bottled goods, maybe 95% for draught beer to allow for wastage in running through the pipes.

Trackable: For reporting purposes.
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Recipe (Sub)

When creating recipes, a component may itself have a recipe. For example, for a liqueur coffee, the recipe record could list all the components and include just one line for the coffee element. A recipe for the coffee would be setup as a 
sub recipe. This option is covered in greater detail in the Creating Sub-Recipes topic.

For a description of the fields, refer to the Recipe topic.

Supplier

A Supplier is an individual or a company who supplies products to outlets such as food suppliers, soft drink suppliers, Cash & Carry.

Each record represents an individual Supplier. The following fields are displayed on the Supplier option:

Supplier ID: Automatically populated with unique Supplier ID number.

Description: Name or brief description (up to 20 characters long) of Supplier.

Address: Address of Supplier. Four lines are available, with up to 20 characters per line.

Telephone: Telephone number of Supplier.

Fax: Fax number of Supplier.

E-Mail: E-mail address of Supplier.

VAT: Rate of tax.

The next three fields are used to determine which code is displayed by default next to a product on the Outlet Transfers and Room Transfers screens (for both deliveries and orders). Only one of the three should be enabled.

Show Product Reference: Reference code for a product.

Show Supplier Reference: Alternative reference for a product.

Show Customer Reference: Alternative reference for a product.

Complete Part Delivered Orders: Identifies for a given supplier on delivery against a confirmed order if there is a shortfall in the delivery whether the order is set to COMPLETE or if it remains PART DELIVERED. If selected, the order is set 
to Completed by updating the order against the delivered quantities and then completing any shortfalls in the delivery. The shortfalls in the ordered quantity are identified as Not Delivered. If not selected, shortfalls in the delivery remain On 

Order in Part Delivered Orders.
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Screen Designer Overview

The Screen Designer option allows creation or modification of the touch panels/sales screens displayed on the terminals. It also allows the Command Window, used for displaying prompts and menu lists on the terminal, to be modified.

What would you like to do ?

Display a sales touch panel

Learn about the touch panel

Work with buttons

Work with the Command Window

Activate touch wedges

Displaying Sales Panels

To open a Sales screen:

ACCESS THE Screen Designer OPTION.

If you are modifying an existing button layout, the sales screens are contained within the Main Screen area of the Explorer 1 panel. If you are creating a new button layout, the screen is located under the Free Panels area. To create a new 
sales screen, the Screen Creator record requires completing first.

To display the touch panel:

CLICK ON THE + ICON NEXT TO Main Screen/Free Panels.

A list of names of available main screens/free panels is displayed.

EXPAND THE DESIRED MAP. (For main screens only.)

The name of available touch panel headers is displayed.

RIGHT-CLICK THE DESIRED TOUCH PANEL HEADER.

A sub-menu opens. 

SELECT Screen Designer...

The selected touch panel opens. The area on the right will show the existing button layout. For new touch panels, only the Command Window is displayed.

EXAMPLE (existing sales panel)

About the Touch Panel

Most of the touch panels displayed on a terminal are of the Sales type, although, there should always be a Logon touch panel, and a Yes/No touch panel for standalone purposes. The Sales touch panel contains buttons representing the 
items sold at a outlet (base sales items and SITs) along with their appropriate SIDs and SIPs, and buttons routed to other touch panels.

The area on the right shows the existing button layout for the selected touch panel header. For new touch panels, only the Command Window is displayed. The example below, represents the button layout for the touch panel header titled 
BAR.

This example shows the Command Window positioned centrally at the top and is used for displaying prompts and menu lists.

The button shape, colour, text format, text colour and image are managed via the Properties window for the selected buttons.

A button on a touch screen can be attached to one of the following items:

Sales Item Descriptor

Sales Item Terminator

Products
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Sales Item Preparator/Order Messages

A Point of Sale Action Module (PAM)

Another Touch Panel

Activating Touch Wedges

Options specific to Touch Wedges such as DALKEY, Adjust Contrast and Volume, can be activated within the Screen Designer.

Note: The menu option is greyed out if the options have already been activated.

Buttons Overview

Sales touch panels displayed on a terminal contain buttons. These buttons represent base sales items or for other sales items such as draught products, their appropriate SID's and SIT's . Other buttons route to other touch panels. For 
example, a button called Bottle List links to another touch panel containing buttons relating to the various bottle items sold at an outlet.

Buttons may be added, deleted, resized or moved. Their properties such as shape, colour, text format, text colour and image are all managed via the Properties window.

What would you like to do ?

Select a single button

Select multiple buttons

Add a button

Move a button

Change the size of a button

Delete a button

Change the shape of a button

Change the colour of a button

Add an image to the button

Selecting Buttons

Touch panel buttons require selecting before they can be moved, deleted or have their properties changed. This topic explains selecting buttons from the displayed touch panel.

Action What to do

To activate touch wedge options: CLICK ON Activate ON THE MENU BAR.

SELECT Activate Touch Wedge Terminals.

CLICK ON THE Yes BUTTON.

If the checks are successful, changes made are confirmed by a message box.

CLICK THE OK BUTTON.

© Torex Retail Holdings Limited 2011. All rights reserved.

Action What to do

To select an individual button: CLICK ON THE DESIRED BUTTON. For example HOUGHTON PILS.

When the button is selected, it has eight small selection handles around it.

To select multiple individual buttons: CLICK ON THE FIRST DESIRED BUTTON.

HOLD DOWN THE Ctrl KEY WHILST SELECTING THE NEXT REQUIRED BUTTON(S).

Selected buttons are surrounded by eight small selection handles. Our example below shows 2 selected buttons:
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Adding Buttons

Individual or multiple buttons (Products, SIDs, SITs, SIPs, PAMs), may be added to the touch panel layout using the Screen Designer option as described below. Alternatively, these buttons may be added when each record is created 
within the appropriate System Configuration e-POS option. 

Note: Use the Ctrl key for selecting multiple buttons.

To select a group of adjacent buttons: CLICK IN A BLANK AREA AND DRAG THE CURSOR OVER THE REQUIRED SELECTION.

(A dotted line follows the cursor movement.)

CLICK TO SELECT.

When the buttons are selected, they have eight small selection handles around each button as shown below:

Subsequently, the Ctrl key may be used to add/remove individual buttons from the group selection.

Method What to do

Clicking the required items from the left pane of the Explorer panel and 
dragging the items onto the layout.

This method is the easiest method but alternative methods of adding buttons 
follow:

Adding a single button:

SELECT THE REQUIRED ITEM AND DRAG INTO POSITION.

EXAMPLE (single button)

Adding multiple buttons:

CLICK ON THE FIRST DESIRED ITEM.

HOLD DOWN THE Ctrl KEY WHILST SELECTING THE NEXT ITEM(S).

DRAG INTO POSITION ON TOUCH PANEL.

A sub-menu opens allowing the items to be dropped horizontally (across) or vertically (down) the touch panel.

SELECT AN OPTION.

EXAMPLE (multiple buttons)

Alternative Methods What to do

Clicking the required items from the left pane and using Edit and Copy from 
the Menu bar.

SELECT THE REQUIRED ITEM.

SELECT Copy FROM THE Edit PULL-DOWN MENU.

CLICK IN A BLANK AREA OF THE BUTTON LAYOUT.

SELECT Paste FROM THE Edit PULL-DOWN MENU.

SELECT THE PASTED ITEM AND DRAG INTO DESIRED POSITION.

EXAMPLE (single button)

Clicking the required items from the left pane and using Copy from right-
clicking.

SELECT THE REQUIRED ITEM AND RIGHT-CLICK.

SELECT Copy FROM THE SUB-MENU.

RIGHT-CLICK IN A BLANK AREA OF THE BUTTON LAYOUT.

SELECT Paste FROM THE SUB-MENU.

SELECT THE PASTED ITEM AND DRAG INTO DESIRED POSITION.

EXAMPLE (single button)

Copying buttons from another layout. OPEN THE SOURCE TOUCH PANEL CONTAINING THE BUTTON TO COPY.

SELECT AND COPY THE BUTTON. (Using the Edit/Copy facility from the Menu bar or by right-clicking.)

OPEN THE DESTINATION TOUCH PANEL.

PASTE THE BUTTON. (Using the Edit/Paste facility from the Menu bar or by right-clicking.)

DRAG INTO DESIRED POSITION.
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Moving Buttons

Individual buttons may be repositioned to another location on the panel without the need of deleting and adding the button again.

Resizing Buttons

Individual buttons may also be resized on the touch panel layout.

Deleting Buttons

EXAMPLE (single button)

EXAMPLE (multiple buttons)
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Action What to do

To move a button to a different position on the panel: SELECT BUTTON(S) TO MOVE.

DRAG TO DESIRED POSITION.

For example, to move an individual button:

CLICK ON THE DESIRED BUTTON. For example LARGE DASH.

DRAG TO DESIRED POSITION.

Action What to do

To change the size of a button: SELECT BUTTON.

When the button is selected, it has eight small selection handles around it. The corner handles enable you to resize a button from two sides. The middle handles 
enable scaling from just one side. Whenever, you drag a handle, the opposite handle stays anchored to its current position.

DRAG A HANDLE TO CHANGE ITS SIZE.

A button can only be resized in proportion to the original button size, that is double its width or height, or both as shown below.

The text size shown on the button will automatically adjust with the resizing of a button.

Action What to do

To delete buttons from the touch panel: SELECT BUTTON(S) TO DELETE.
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Button Properties

The button shape, colour, text format, text colour and image are managed via the Properties window for the selected buttons.

Changing Button Shape

The button shape is managed via the Properties window. Open the Properties window for the chosen buttons.

The original button shape is shown.

EXAMPLES of these button shapes.

Changing Text Format

The format of the text on the buttons is managed via the Properties window. Open the Properties window for the chosen buttons.

Note: Use the Ctrl key for selecting multiple buttons.

RIGHT-CLICK.

A sub-menu opens:

SELECT THE Delete OPTION.

A confirmation window opens.

CLICK THE Yes BUTTON.

EXAMPLE (individual button)

EXAMPLE (multiple buttons)
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Action What to do

To open the Properties window: SELECT BUTTON(S) TO CHANGE ON LAYOUT OR LEFT PANE.

RIGHT-CLICK.

A sub-menu opens.

SELECT THE Properties... OPTION.

A thumbnail representation of the buttons selected, is displayed on the right side of this window. As each change is made to the button properties, it is updated to 
reflect the changes made

Action What to do

To change the button shape: SELECT THE DESIRED Button Shape FROM THE DROP-DOWN LIST.

The graphic representation is updated.

Amend the button colour, text format, text colour and/or image attributes as necessary.

When all amendments have been made, to save the changes:

CLICK THE Save BUTTON.
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EXAMPLES of the different text formats.

Changing Button Colour

The button colour is managed via the Properties window. Open the Properties window for the chosen buttons.

The button and text colours may be changed independently.

For example, the thumbnail below represents a hexagonal blue button with white text vertically centered.

Changing Text Colour

The text colour is managed via the Properties window. Open the Properties window for the chosen buttons.

Action What to do

To change the text format: SELECT THE DESIRED Text Format FROM THE DROP-DOWN LIST.

The graphic representation is updated to reflect the text changes.

Amend the button shape, colour, text colour and/or image attributes as necessary.

When all amendments have been made, to save the changes:

CLICK THE Save BUTTON.

© Torex Retail Holdings Limited 2011. All rights reserved.

Action What to do

To change the button colour: CLICK THE Button Colour BUTTON.

The Colour Palette opens with 16 colours selected. You may select one of these colours to use, or change the colour palette.

When the chosen colour has been selected:

CLICK THE OK BUTTON.

The graphic representation is updated.

Amend the button shape, text format, text colour and/or image attributes as necessary.

When all amendments have been made, to save the changes:

CLICK THE Save BUTTON.

Action What to do

To change the text colour: CLICK THE Text Colour BUTTON.

The Colour Palette opens with 16 colours selected. You may select one of these colours to use, or change the colour palette.

When the chosen colour has been selected:
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For example, the thumbnail below represents a hexagonal blue button with red text vertically centered.

Changing the Colour Palette

When changing button and text colours, the Colour Palette initially opens with 16 colours selected. You may select one of these colours to use, or change the colours in the palette to create a new palette.

Adding Images

Adding images to buttons is managed via the Properties window. Open the Properties window for the chosen buttons.

CLICK THE OK BUTTON.

The graphic representation is updated.

Amend the button shape, colour, text format and/or image attributes as necessary.

When all amendments have been made, to save the changes:

CLICK THE Save BUTTON.

Action What to do

To create a new Colour Palette: SELECT A COLOUR.

CLICK THE Custom... BUTTON.

SELECT A COLOUR OR PROCEED TO Define Custom Colors.

Define Custom Colors allows other colours to be chosen from a colour matrix and added to the Custom colours. It contains its own Help system if required.

After selecting the chosen colour:

CLICK THE OK BUTTON.

The chosen colour will be added to the Colour Palette.

CLICK THE Save Palette BUTTON.

CLICK THE OK BUTTON.
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EXAMPLE

Saving the Changes

The button shape, text format, colour and image are managed via the Properties window for the selected buttons.

Command Window Overview

The Command Window is used for displaying prompts and menu lists on the terminal. These menu options may be added to, deleted or re-ordered.

What would you like to do ?

Learn about the Command Window

Change the colour of the Command Window

Display a window panel

Add a menu option

Delete a menu option

Change the menu option order

About the Command Window

The Command Window is used for displaying prompts and menu lists on the terminal. The terminal number and server name are also displayed. To view the menus refer to the Displaying the Window Panel topic.

Action What to do

To add an image to a button: SELECT THE GoTo BUTTON ADJACENT TO THE Picture FIELD.

NAVIGATE TO THE DESIRED IMAGE.

CLICK THE OK BUTTON.

The thumbnail representation is updated to reflect the image added. Amend the button shape, colour and text attributes as necessary.

When all amendments have been made,

CLICK THE Save BUTTON.
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Action What to do

To save any changes to the Properties window: CLICK THE Save BUTTON.

A caution window opens stating that all instances of the buttons on all panels are effected.

CLICK THE Yes BUTTON.

For each button initially selected for property changes, an individual 'Save Properties for ....' window opens.

CLICK THE Yes BUTTON FOR EACH BUTTON.

© Torex Retail Holdings Limited 2011. All rights reserved.

© Torex Retail Holdings Limited 2011. All rights reserved.

Page 8 of 12Screen Designer Overview



The position and size of the Command Window is controlled from the Touch Panel Headers/Terminal Type settings but it is possible to have a free moving Command Window. How ?

Note: The Command Window can not be positioned on top of any existing buttons.

Changing the Window Colour

The colour of the Command Window is managed via the Properties window.

Display a Sales touch panel so that the Command Window is shown.

Displaying the Window Panel

To display the Command Window panel:

ACCESS THE Screen Designer OPTION.

To expand the Window Panel:

CLICK ON THE + ICON NEXT TO Window Panel.

© Torex Retail Holdings Limited 2011. All rights reserved.

Action What to do

To change the Command Window colour: SELECT THE COMMAND WINDOW.

RIGHT-CLICK.

A sub-menu opens.

SELECT THE Properties... OPTION.

SELECT THE Command Window Colour BUTTON.

The Colour Palette opens with 16 colours selected. You may select one of these colours to use, or change the colour palette.

When the chosen colour has been selected:

CLICK THE OK BUTTON.

CLICK THE Save BUTTON.

CLICK THE Yes BUTTON.
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To open the Window Panel for Management Functions:

DOUBLE-CLICK MGT. FUNCTIONS.

The menu options of the Window Panel may be added to, re-ordered or deleted.

Adding Options

Options may be added to a menu list displayed on the Command window of a terminal.

Display the Window Panel to add a menu option to.

Deleting Options

Options may be deleted from a menu list displayed on the Command window of a terminal.

Display the Window Panel to delete a menu option from.

Changing the Order

The order of menu options displayed on the Command window of a terminal may be changed.

Display the Window Panel to change the menu options on.

Action What to do

To add a menu option to a Window Panel: SELECT THE MENU OPTION TO ADD FROM THE EXPLORER PANEL.

DRAG ONTO THE OPEN WINDOW PANEL.

When the desired menu options have been added:

CLICK THE Save BUTTON.

A confirmation window opens.

CLICK THE OK BUTTON.

EXAMPLE
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Action What to do

To delete a menu option from a Window Panel: SELECT THE MENU OPTION(S) TO DELETE.

Use with the Ctrl key for multiple options.

CLICK THE Delete BUTTON.

CLICK THE Save BUTTON.

A confirmation window opens:

CLICK THE OK BUTTON.

EXAMPLE
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Displaying a New Touch Panel

To create a new touch panel, the Screen Creator record requires completing first. This header is placed in the Free Panels area of the Touch Panel Designer.

To display the touch panel:

CLICK ON THE + ICON NEXT TO Free Panels.

The name of available Touch Panels is displayed.

DOUBLE-CLICK THE DESIRED TOUCH PANEL. For example BOTTLE LIST.

The touch panel is displayed in the area on the right and shows only the Command Window as set via the Screen Creator.

Adding the Buttons

Individual or multiple buttons (Products, SIDs, SITs, SIPs, PAMs), may be added and dragged into position on the touch panel.

Action What to do

To move a menu option on a Window Panel: SELECT THE MENU OPTION TO MOVE.

A double headed arrow appears on the selected line.

CLICK AND DRAG ON THE GREY CELLS TO MOVE THE SELECTED OPTION TO THE DESIRED POSITION. For example Top Position.

CLICK THE Save BUTTON.

A confirmation window opens.

CLICK THE OK BUTTON.

EXAMPLE
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Method What to do

Clicking the required items from the left pane and dragging the items onto 
the layout.

Adding a single button:

SELECT THE REQUIRED ITEM AND DRAG INTO POSITION.

EXAMPLE (single button)

Adding multiple buttons:

CLICK ON THE FIRST DESIRED ITEM.

HOLD DOWN THE Ctrl KEY WHILST SELECTING THE NEXT ITEM(S).

DRAG INTO POSITION ON TOUCH PANEL.

A sub-menu opens allowing the items to be dropped horizontally (across) or vertically (down) the touch panel.

SELECT AN OPTION.

EXAMPLE (multiple buttons)
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The button shape, colour, text format, text colour and image are all managed via the Properties window for the selected buttons.

Linking to a New Main Screen

The touch panel needs to be linked to a Main Screen. A new main screen may be created or the touch panel can be linked to an existing main screen.

EXAMPLE

Linking to an Existing Main Screen

The touch panel needs to be linked to a main screen. A new main screen may be created or the touch panel can be linked to an existing main screen.

EXAMPLE

© Torex Retail Holdings Limited 2011. All rights reserved.

Method What to do

To create a new main screen: SELECT THE REQUIRED TOUCH PANEL FROM THE Free Panels AREA.

RIGHT-CLICK AND SELECT New... FROM THE SUB-MENU.

CREATE A NEW MAIN SCREEN RECORD TO ASSOCIATE WITH THIS TOUCH PANEL.

CLOSE THE Main Screen RECORD.

DOUBLE-CLICK THIS MAIN SCREEN.

SELECT THE REQUIRED TOUCH PANEL AS THE Sales Panel.

CLICK THE Save BUTTON.

CLICK THE OK BUTTON.

CLICK THE Close BUTTON.

RIGHT-CLICK ON THE NEW KEY MAP.

Refresh THE NEW KEY MAP.

The touch panel will no longer be shown under Free Panels but is located with the new main screen created.

© Torex Retail Holdings Limited 2011. All rights reserved.

Method What to do

To link to an existing main screen: DOUBLE-CLICK THE EXISTING MAIN SCREEN.

SELECT THE REQUIRED TOUCH PANEL FROM THE Free Panels AREA.

DRAG THE TOUCH PANEL ONTO THE EXISTING LAYOUT.

RIGHT-CLICK ON THE EXISTING MAIN SCREEN.

Refresh THE EXISTING KEY MAP.

The new touch panel is displayed within the existing Main Screen list.
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Generating Sales Items

Sales items are the actual items sold at an outlet and are represented by buttons on a terminal. As many sales items can be sold in several quantities and forms, it is not recommended to have a single button for each and every 
permutation of a sales item. SIDs and SITs are used together to reduce the number of buttons displayed on a terminal screen.

Sales items may be generated:

 one by one using the e-POS Sales Item option 

 or the system can automatically generate Sales Items from SIDs and SITs using the Build Sales Items option.

Click on one of the above options to continue with the help for creating Sales Items.

Creating New Records

Open the System Configuration window. How ?

Open the Sales Item Maintenance Form. How ?

New individual sales item records can be created in two ways:

Click on one of the above options to continue with the help for creating a new individual Sales Item record.

Blank Maintenance Form

To create a new Sales Item record from a blank Maintenance Form. 

Open the Sales Item Maintenance Form. How ?

CLICK ON THE New BUTTON ON THE Mode : View TOOLBAR.

A blank record opens. Certain fields such as unique ID numbers are automatically filled with the lowest available number. The cursor will be flashing in the Description field. Each record will represent an individual Sales Item.

At the bottom of the blank record, a description of the input required is displayed. As you progress through the input fields, the description updates to reflect the information required. Text entered may automatically appear in uppercase but 
this is configurable.

TYPE THE ENTRY FOR THE Description FIELD.

PRESS TAB OR CLICK ON THE Keyboard Text FIELD.

TYPE THE NEXT ENTRY.

CONTINUE FOR EACH INPUT FIELD.

Click for more information on the fields displayed on the Sales Item record.

When all fields have been completed, save the record. How ?

When you add a new record, it will be placed after the last existing record and the Record Toolbar caption will show an increment of one. It is not necessary to enter records in a particular order as you can easily rearrange them by 
sorting using the Order button.

Note: If the Save button is clicked whilst no data or incomplete data is entered in the input fields, an error window will open. This window will list the empty fields.

Example shown below represents a completed Sales Item record. 

Existing Record

To create a new record from an existing record.

Open the Sales Item Maintenance Form. How ?

from a blank Maintenance Form or,

copied from an existing record.

© Torex Retail Holdings Limited 2011. All rights reserved.
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Locate the record you wish to copy using the Record Toolbar or the Find button.

CLICK THE Copy BUTTON ON THE Mode : View TOOLBAR.

The Maintenance Form for that record opens. It is an exact duplicate of the original record except any unique ID numbers will be updated to reflect the next lowest number available.

AMEND FIELDS AS NECESSARY TO CREATE A NEW RECORD.

When all fields have been completed, save the record. How ?

When you add a new record, it will be placed after the last existing record and the Record Toolbar caption will show an increment of one. It is not necessary to enter records in a particular order as you can easily rearrange them by sorting 
using the Order button.

Note: If the Save button is clicked whilst no data or incomplete data is entered in the input fields, an error window will open. This window will list the empty fields.

Example shown below represents a completed Sales Item record.

Building Sales Items

Sales items, (SID /SIT combinations), may be generated automatically using the Build Sales Items option. Before starting to generate these sales items, records must exist for certain other options. More information

Open the Build Sales Items window. How ?

To generate Sales items follow the Action steps below:

EXAMPLE
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Action What to do

To select a Sales Item Terminator: CLICK THE ARROW BUTTON AT THE END OF THE Terminator FIELD.

A drop-down list of available SITs is displayed.

CLICK THE REQUIRED SIT.

The selected SIT will be displayed and highlighted in the field.

All possible Sales Items from the combinations of the descriptors for the selected terminator are generated and displayed in the Description field.

Note: Items shown with a yellow background have already been created.

To display the item name first (optional): CLICK THE Name First BUTTON.

The name of the item will be displayed, followed by its descriptor.

The Name Second button is only displayed when the Description shows the name first. Using this button, the Sales Items can be shown with the descriptor first, for 
example PT BREW.

To select all generated combinations: CLICK THE Select All BUTTON.

To select individual generated Sales Items: CLICK THE CHECK BOX ADJACENT TO THE REQUIRED SALES ITEM.

A tick in the check box indicates the Sales Item is selected. The Build button becomes available when at least one Sales Item has been selected.

To build these selected items: CLICK THE Build BUTTON.

A question prompt will open showing the SID/SIT combinations to create.

To confirm the build:

CLICK THE Yes BUTTON.

CLICK THE OK BUTTON.

To amend the Print Group : CLICK THE ARROW BUTTON AT THE END OF THE Print Group FIELD.

A drop-down list of available groups is displayed.

CLICK THE REQUIRED PRINT GROUP.

To amend the Print Format : CLICK THE ARROW BUTTON AT THE END OF THE Print Format FIELD.

A drop-down list of available formats is displayed.

CLICK THE REQUIRED PRINT FORMAT.

To amend the VAT rate: CLICK THE ARROW BUTTON AT THE END OF THE VAT FIELD.

A drop-down list of available rates is displayed.

CLICK THE REQUIRED VAT.

To save the generated Sales Items: CLICK THE Close BUTTON.
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Summary

Below is a summary of building SID /SIT sales items. For more details of the procedure, refer to the Building Sales Items topic.  Click here to jump to this topic.

SELECT THE DESIRED Terminator

SELECT THE REQUIRED COMBINATIONS

CLICK THE Name First BUTTON (optional)

CLICK THE Build BUTTON

CONFIRM THE BUILD ITEM(S)

CLICK THE OK BUTTON ON CONFIRMATION OF THE BUILD

CHANGE AS NECESSARY THE Print Group, Print Format AND VAT OPTIONS

CLICK THE Close BUTTON
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Updating Selling Prices

The Update Selling Prices option contains records of each sales item and its corresponding selling price for each trading area and mode. These selling prices may be updated.

What would you like to do ?

Select when the price changes take effect

Change prices of individual items

Change prices of a group of items

View pending price changes

When to Take Effect

Selling prices may be updated with the price change to take effect at the next session or on a chosen date in the future.

Access the Update Selling Prices window. How ?

Changing Single Item Prices

Selling prices may be updated:

 individually for each sales item and its corresponding trading modes and trading areas 

 or for a group of sales items and their corresponding trading modes and trading areas

An individual sales item may be selected by entering the Sales Item ID number or by navigating through the records to locate the required item. 

The grid is updated to reflect the selling prices of the selected sales item for each trading area and mode.

Action What to do

If the price update is not to take place at next extract: CLICK THE Date Effective On OPTION BUTTON.

ENTER A DATE OR USE THE CALENDAR TO SELECT A NEW DATE.

CLICK THE Next > BUTTON.

If the price update is to take place at next session: CLICK THE Next > BUTTON.
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Action What to do

To select a Sales Item from its Base Sales Item ID number: ENTER THE REQUIRED Base Sales Item ID NUMBER.

To select a Sales Item by navigating through sequential records: The outer buttons represent the Go To commands for the first and last record respectively. The inner buttons allow navigation, one record at a time, forwards and 
backwards. 

CLICK THE APPROPRIATE BUTTON FOR THE DIRECTION OF TRAVEL REQUIRED.

The Base Sales Item ID number is updated accordingly.

Action What to do
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EXAMPLE

Price changes made during the current session can be viewed using the View Changes button.

Changing Multiple Item Prices

Selling prices may be updated:

 individually for each sales item and its corresponding trading modes and trading areas

 or for a group of sales items and their corresponding trading modes and trading areas

Multiple sales items are selected from the tree structure.

Trading areas are displayed on the right side of the window. As default, all trading areas are selected, denoted by a tick. If selective trading areas are required, they may be selected or deselected individually or all at once. How ?

When sales items are selected, the selling price for each trading mode is displayed if the selling price is the same for all the sales items in the trading areas selected.

Note: If selling prices are different for the selected sales items or trading areas, no original prices are displayed.

EXAMPLE

Price changes made during the current session can be viewed using the View Changes button.

Viewing Changes

Items with price changes made during the current session may be viewed to confirm the changes. 

EXAMPLE

Any sales items showing incorrect price changes that are still pending, may be deleted from the View Price Changes window. How ?

Summary

To enter a new price: CLICK THE CELL FOR THE DESIRED Trading Mode AND Trading Area.

TYPE IN THE Selling Price REQUIRED.

Repeat for each selling price required. 

To apply the changes: CLICK THE Apply BUTTON.
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Action What to do

To select a sales level using the tree structure: Items prefixed with a '+' contain more information and are available for opening.

Items prefixed with a '-' are already opened and displaying their sub-groups.

DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.

To select all items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.

CLICK THE Select All BUTTON. 

To select individual items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE BASE SALES ITEM LEVEL IS DISPLAYED.

SELECT THE REQUIRED ITEM.

To deselect all items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.

CLICK THE Deselect All BUTTON. 

To deselect individual items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE BASE SALES ITEM LEVEL IS DISPLAYED.

SELECT THE REQUIRED ITEM.

Action What to do

To enter a new price: CLICK THE New Price CELL FOR THE DESIRED Trading Mode.

TYPE IN THE New Price OR USE THE SPIN BUTTONS PROVIDED.

To apply the changes: CLICK THE Apply BUTTON.
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Action What to do

To view the changes: CLICK THE View Changes... BUTTON.

Two views are available:

 View Pending - shows sales items that are awaiting for the price changes to take effect, and,

 View Actioned - shows sales items that the price changes have taken effect.

CLICK THE Close BUTTON.

CLICK THE OK BUTTON.
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Updating Selling Price Specials

Prices may be updated for each sales item that is classified as a special (where the price can be changed at the terminal). The price change(s) will take effect at the next session and covers all trading modes and areas.

What would you like to do ?

Change prices of individual items

Change prices of a group of items

View pending price changes

Changing Single Item Prices

Access the Update Selling Price Specials window. How ?

Selling prices may be updated:

 individually for each sales item and its corresponding trading modes and trading areas 

 or for a group of sales items and their corresponding trading modes and trading areas

An individual sales item may be selected by entering the Sales Item ID number or by navigating through the records to locate the required item. 

EXAMPLE

Price changes made during the current session can be viewed using the View Changes button.

Changing Multiple Item Prices

Selling prices may be updated:

 individually for each sales item and its corresponding trading modes and trading areas

 or for a group of sales items and their corresponding trading modes and trading areas

Multiple sales items are selected from the tree structure.

Summary of Updating Selling Prices:

1. SELECT WHEN THE CHANGES ARE TO TAKE EFFECT

2. CLICK THE Next BUTTON

3. SELECT THE Sales Item(s) TO UPDATE

4. ENTER THE NEW PRICES FOR EACH TRADING MODE AND TRADING AREA AS REQUIRED

5. CLICK THE Apply BUTTON

6. CLICK THE View Changes BUTTON (Optional)

Action What to do

To select a Sales Item from its Base Sales Item ID number: ENTER THE REQUIRED Base Sales Item ID NUMBER.

To select a Sales Item by navigating through sequential records: The outer buttons represent the Go To commands for the first and last record respectively. The inner buttons allow navigation, one record at a time, forwards and 
backwards. 

CLICK THE APPROPRIATE BUTTON FOR THE DIRECTION OF TRAVEL REQUIRED.

The Base Sales Item ID number is updated accordingly.

To enter a new price: CLICK THE All Trading Modes  AND All Trading Areas CELL.

TYPE IN THE Selling Price REQUIRED.

To apply the changes: CLICK THE Apply BUTTON.
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Action What to do

To select a sales level using the tree structure: Items prefixed with a '+' contain more information and are available for opening.

Items prefixed with a '-' are already opened and displaying their sub-groups.

DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.

To select all items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.
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Trading areas are displayed on the right side of the window. As default, all trading areas are selected and cannot be deselected.

EXAMPLE

Price changes made during the current session can be viewed using the View Changes button.

Viewing Changes

Items with price changes made during the current session may be viewed to confirm the changes. 

EXAMPLE

Any sales items showing incorrect price changes that are still pending, may be deleted from the View Price Changes window. How ?

Summary

Price Lists Overview

A Price (Bar Tariff) List shows different sales items in defined groups and their relevant selling price. To create a new price list, the structure of the price list (groups names and hierarchical level of items to select from) needs to be built 
first. Subsequently, individual items from the selected hierarchical level can be added to these group names to create the content of the price list.

What would you like to do ?

Create a new group name

Choose a hierarchical level

Add individual items to a group

Print the price list

Change a group name

Delete a group

CLICK THE Select All BUTTON.

To select individual items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE BASE SALES ITEM LEVEL IS DISPLAYED.

SELECT THE REQUIRED ITEM.

To deselect all items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE REQUIRED LEVEL IS DISPLAYED.

CLICK THE Deselect All BUTTON.

To deselect individual items within a sales level: DOUBLE-CLICK '+' FOR EACH LAYER OF HIERARCHY UNTIL THE BASE SALES ITEM LEVEL IS DISPLAYED.

SELECT THE REQUIRED ITEM.

Action What to do

To enter a new price: CLICK THE New Price CELL.

TYPE IN THE New Price OR USE THE SPIN BUTTONS PROVIDED.

To apply the changes: CLICK THE Apply BUTTON.
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Action What to do

To view the changes: CLICK THE View Changes... BUTTON.

Two views are available:

 View Pending - shows sales items that are awaiting for the price changes to take effect, and,

 View Actioned - shows sales items that the price changes have taken effect.

CLICK THE Close BUTTON.

CLICK THE OK BUTTON.
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Updating Selling Price Specials:

1. SELECT THE Sales Item(s) TO UPDATE

2. ENTER THE NEW PRICES

3. CLICK THE Apply BUTTON

4. CLICK THE View Changes BUTTON (Optional)
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Setting Up Group Names

When creating the structure of the price list, the group names need to be set up first.

Access the Update Price List Designer window. How ?

To add a new group title:

CLICK ON ONE OF THE ADD NEW BUTTONS.

There are 4 add new buttons. They each allow a new group title to be added but the position within the list is governed by which of the buttons is used. More information

CONTINUE TO ADD NEW GROUP TITLES AS REQUIRED.

EXAMPLE

Once group titles have been created, the hierarchical level of items to add to the price list require selecting.  Click here to go to this topic.

Adding Hierarchical Levels

When creating the structure of the price list, the hierarchical level of items available to add to the price list require selecting.

To add an hierarchical level to a group title:

On the Update Price List Designer window,

FROM THE Retail Price List Skeleton SELECT THE GROUP TO ADD TO.

Available items to add are shown in the sales hierarchy format. Any level of the sales hierarchy can be selected. For example, if a GSI Group is selected, all sales items that belong to this GSI Group are available when selecting items to 
print on the Price List. If specific BSI's are selected, only these sales items are available when selecting items to print on the Price List.

To expand the hierarchical structure:

DOUBLE-CLICK THE PLUS SIGN UNTIL THE REQUIRED LEVEL IS DISPLAYED.

To add to the selected group:

HIGHLIGHT THE REQUIRED LEVEL TO ADD.

CLICK THE ADD BUTTON.

EXAMPLE

When all required hierarchical levels have been added to their respective groups, the items to print on the price list need selecting.  Click to go to this topic.

Adding Items to Groups

Price lists contain individual sales items (and their respective prices) displayed in groups. These individual items need to be selected from the hierarchical levels.

Access the Update Price List window. How ?
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To create the content of the price list:

SELECT A Price List Group.

CLICK ON THE EDIT BUTTON.

Sales items for the selected Price List Group are shown. Those items within the Selected Items area appear on the Price List report. 

Several sales items may be selected for transfer at once. How ?

The transfer of available items from the selected Price List Group, is carried out via a set of four buttons. These buttons allow sales items to be added or removed. 

Click here to learn more about these buttons.

SELECT THE ITEM(S) TO ADD.

CLICK THE Add > OR Add All >> BUTTON.

CLICK ON THE SAVE BUTTON.

A confirmation window opens.

CLICK ON THE Yes BUTTON.

REPEAT THE PROCESS FOR ANOTHER Price List Group IF REQUIRED.

CLICK ON THE OK BUTTON.

EXAMPLE

Printing the Price List

Whenever there are price changes, a message is sent to the Exception Auditor to advise the outlet to reprint the Price List using Reports & Views.

Producing a price list will not print unless there is at least 30 items selected in total.

Changing Group Names

Group names as displayed on Price Lists may be changed.

Access the Update Price List Designer window. How ?

FROM THE Retail Price List Skeleton SELECT THE GROUP TO CHANGE.

CLICK ON THE EDIT BUTTON. 

RENAME THE GROUP TITLE.

EXAMPLE

Deleting Groups

Groups (content and title) as displayed on Price Lists may be deleted.

Access the Update Price List Designer window. How ?

FROM THE Retail Price List Skeleton SELECT THE GROUP TO DELETE.

CLICK ON THE DELETE BUTTON.

EXAMPLE
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Validate and Install Bulk Update

The Validate & Bulk Update option is a method of updating the system touch panels with new ones, sent from a central location. It can also update other information such as Selling Prices, Sales Item Routes and SIPs . The target 
installation date is checked every night by the system. A message is written to the Exception Auditor if the date has passed informing that the Bulk Update file is to be installed.

It is a two stage process:

 First, the data file must be validated and, if validation is successful,

 the file may be installed.

This option is covered in detail in the Bulk Update Help book.

 Click here to continue with Help on validating and installing the data file.

Installing Files

After successful validation of the data file, it may be installed.

To install the data file:

CLICK THE Install BUTTON.

If the Install button is selected before the target installation date has been reached, an information message box opens informing of this and allowing the choice of installing the data file anyway. EXAMPLE

If installation is successful, the following window opens:

CLICK THE OK BUTTON.

The window updates to show both the Validation and Installation processes have completed successfully.

To exit this window:

CLICK THE Close BUTTON.

Installing Files

After successful validation of the data file, it may be installed.
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To install the data file:

CLICK THE Install BUTTON.

If the Install button is selected before the target installation date has been reached, an information message box opens informing of this and allowing the choice of installing the data file anyway. EXAMPLE

If installation is successful, the following window opens:

CLICK THE OK BUTTON.

The window updates to show both the Validation and Installation processes have completed successfully.

To exit this window:

CLICK THE Close BUTTON.
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Adding Recipes

Recipes are the links between Sales Items and Stock. Each time a Sales Item is sold, the outlet's stock of the various components that form part of that Sales Item, must be decreased by the appropriate amount. This is achieved by 
setting up a Recipe for each Sales Item that contains more than one component. The Recipe for a Sales Item states the proportions of each stock component in that Sales Item. The appropriate amounts of each component are then 
removed from the outlet's stock.

Open the Recipe Design window. How ?

EXAMPLE

EXAMPLE USING A SUB-RECIPE

Creating Sub-Recipes

When creating recipes, a component may itself have a recipe. For example, for meals containing a salad component, the recipe record could list all the components of the meal and include just one line for the salad elements. A recipe for 
the salad would be setup as a sub recipe. Likewise for a liqueur coffee, a sub recipe can be setup for the coffee element.

Open the Sub Recipe Design window. How ?

Action What to do

To select a Sales Item: CLICK THE ARROW BUTTON AT THE END OF THE Sales Item FIELD.

CLICK THE REQUIRED Sales Item.

The selected Sales Item is displayed and highlighted in this field.

To add a new recipe item: SELECT THE Edit BUTTON FROM THE Recipe Options TOOLBAR.

SELECT THE New BUTTON FROM THE Recipes Item Options TOOLBAR.

SELECT THE Item Description CELL.

A drop-down list of available Stock items is displayed.

CLICK THE DESIRED COMPONENT.

To add a sub-recipe item: Note: Sub-recipes need to be setup before they can be added. Creating Sub-Recipes

CLICK THE Sub CHECK BOX.

SELECT THE Item Description CELL.

A drop-down list of available sub-recipes is displayed.

CLICK THE DESIRED SUB-RECIPE.

To amend the Unit Description: CLICK THE Unit Description CELL.

A drop-down list of available measurements is displayed.

CLICK THE DESIRED UNIT DESCRIPTION.

The Unit Cost, Quantity and Total Cost cells are automatically updated.

To amend the Quantity: CLICK THE Quantity CELL.

TYPE THE DESIRED QUANTITY.

The Total Cost cells are automatically updated.

To select the Value Apportionment Type: CLICK THE Value Apportionment Type CELL.

A drop-down list of available types is displayed.

CLICK THE DESIRED TYPE.

ENTER Fixed Percentage OR Fixed Value AMOUNT.

Note: Only one Value Apportionment Type may be selected for each record and the sum of all the separate proportions must add up to 100% (Fixed Percentage).

To save the recipe: CLICK THE Save BUTTON ON THE Recipe Options TOOLBAR.
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EXAMPLE

Viewing Sales Analysis

Report, for viewing purposes only, showing analysis of an individual sales item for each Trading Area and Trading Mode.

Open the Recipe Design window. How ?

CLICK THE Sales Analysis TAB.

The following fields are displayed on the Sales Analysis tab.

Action What to do

To enter the Sub-Recipe name: CLICK THE New BUTTON FROM THE Sub Recipe Options TOOLBAR.

ENTER THE SUB RECIPE NAME IN THE Sub Recipe item FIELD.

To add a new sub-recipe item: SELECT THE New BUTTON FROM THE Sub Recipes Item Options TOOLBAR.

SELECT THE Item Description CELL.

A drop-down list of available Stock items is displayed.

CLICK THE DESIRED COMPONENT.

To amend the Unit Description: CLICK THE Unit Description CELL.

A drop-down list of available measurements is displayed.

CLICK THE DESIRED UNIT DESCRIPTION.

The Unit Cost, Quantity and Total Cost cells are automatically updated.

To amend the Quantity: CLICK THE Quantity CELL.

TYPE THE DESIRED QUANTITY.

The Total Cost cells are automatically updated.

To select the Value Apportionment Type: CLICK THE Value Apportionment Type CELL.

A drop-down list of available types is displayed.

CLICK THE DESIRED TYPE.

ENTER Fixed Percentage OR Fixed Value AMOUNT.

Note: Only one Value Apportionment Type may be selected for each record and the sum of all the separate proportions must add up to 100% (Fixed Percentage).

To save the Sub-recipe: CLICK THE Save BUTTON ON THE Sub Recipe Options TOOLBAR.
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Trading Area: Area or room in an outlet where trading takes place such as Bar, Lounge, Restaurant, Function Room.

Trading Mode: The Trading Mode option allows different prices to be charged for the same sales item within a trading area. Usually, incentives occur in a given time frame such as Happy Hour, Sunday Special, student night. Increases in 
prices may occur after midnight for some late night establishments.

Sales Price (Inc Tax): Selling Price of Sales item inclusive of tax.

Coefficient: Calculated by dividing the Sales Price (inc Tax) by the Total Unit Cost.

Sales Price (Exc Tax): Selling Price of Sales item exclusive of tax.

Ratio (%): Cost of Sales. Derived from the Total Unit Cost divided by the Sales Price (exc Tax) x100. For example, if the cost price = 0.50 and the selling price (exc Tax) is £2.00, then 25% of the sales is cost and 75% is gross profit. 

Margin: Sales Price (exc Tax) minus the Total Unit Cost.
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Key Line Tracking Maintenance

Key Line Tracking Maintenance allows for the setup and maintenance of sales items. A maximum of 12 sales items can be tracked and displayed on each of the two FOS reports: Moneybelt Sever Sign Off and Moneybelt Cash Check. 
The tracked items can be either:

 the same on both reports 

 different items on each report 

Summary of Key Line Tracking Maintenance:

1. CHOOSE AN OPTION - EITHER THE SAME OR DIFFERENT SALES ITEMS FOR THE REPORTS

2. CLICK THE Next BUTTON

3. SELECT A SALES CATEGORY FROM THE DROP DOWN LIST THEN SELECT THE SALES ITEM

4. CLICK THE Add BUTTON FOR THE APPROPRIATE REPORT

5. REPEAT STEPS 3 AND 4 FOR EACH SALES ITEM REQUIRED

6. CLICK THE Next BUTTON

7. CLICK THE Finish BUTTON
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